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SIMULATION LAB #4: 
Dynamic Modeling and Simulation  

of Muscle-Tendon Actuators 
 

Modeling and Simulation of Human Movement 

BME 599 

 

Laboratory Developers: Jeff Reinbolt, Hoa Hoang, B.J. Fregly, Kate Saul,  

Darryl Thelen, Silvia Blemker, Clay Anderson, Scott Delp 
 

I. Introduction 
 

The force producing properties of muscle are complex, highly nonlinear and can 

have substantial effects on movement (see McMahon 1984 for review). For 

simplicity, lumped-parameter dimensionless muscle models, capable of 

representing a range of muscles with different architectures, are commonly used in 
the dynamic simulation of movement (Zajac, 1989). In this simulation lab, we will 

review the differential equations that describe muscle activation and muscle-tendon 

contraction dynamics when using a Hill-type muscle model. You will use OpenSim to 

implement muscle-tendon models and conduct simulations to investigate how 

various model parameters affect the dynamic response of the actuators. The lab will 
conclude with a Virtual Muscle Tug-of-War in which you will design an optimal 

muscle and compete directly against others in the class – may the best muscle win! 

II. Objectives 
 

The purpose of this lab is to learn how to use and modify OpenSim models and 

code to model and simulate muscle-tendon dynamics contractions. 

 
By working through this lab, you will: 

 

• Become familiar with the differential equations describing muscle activation 

and muscle-tendon contraction dynamics. 

• Learn how to model and simulate dynamic musculo-tendon actions using 
OpenSim. 

• Become comfortable with modifying existing code that models muscle 

activation and mechanics. 

• Explore the effect of various model parameters and simulation conditions on 

the dynamic response of muscle. 
• Design your own “optimal” muscle-tendon actuator to compete in a virtual 

muscle tug of war. 
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III. Deliverables 
 

At the completion of this lab, you will need to turn in a written report and several 
OpenSim files from your modeling work. 

 

Please turn in: 

 

1. A written report using the report template Simulation_Lab4_report.docx. 

 
2. The following files for the muscle you design (please e-mail to 

reinbolt@utk.edu):  

 

a. YourUTNetID.osim including your muscle as muscle 1. 

b. YourUTNetID.sto and YourUTNetID.xml with your activation history. 
c. YourUTNetID_initialStates.sto with your initial states. 

IV. Getting Started 
 

Download the following files from the course web site: 

 

• Simulation_Lab4_report.docx This file contains the template for the lab 

report. 
• Simulation_Lab4.osim This file contains the template for a two-muscle 

tug-of-war with a block in the middle. You will use the included muscles to 
complete the first part of the lab. You will also use this file to help you design 

your own muscle for the second part of the lab and the tug-of-war 

competition. 
• Simulation_Lab4_Setup_Forward.xml This file contains the parameters 

for running the tug-of-war simulation. 

• Simulation_Lab4_controls.sto This storage file contains example 
excitations for the muscles. 

• Simulation_Lab4_states.sto This storage file contains example initial 

conditions for the muscles. 

• Simulation_Lab4.mot This movement file drives the position of the box for 

kinematic analysis. 
• Geometry This folder contains the polygonal files that describe the surface 

of the box and floor. This folder must be in the same directory as the other 

files and must be named Geometry. 

V. Muscle and Tendon Modeling 
 

In this simulation lab, you will be using Hill-type musculotendon models of the form 

discussed in lecture. Thorough review articles have been written on the 
development and use of Hill-type musculotendon models in dynamic simulations of 

movement (Zajac 1989, Winters 1990). Following is a brief review of the Hill-type 

mailto:reinbolt@utk.edu
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model put forth in those papers, as it has been implemented within OpenSim. If 

you are interested in greater detail, you should consult the references directly. 
 

Activation dynamics 

A muscle cannot generate force or relax instantaneously. The development of force 
is a complex sequence of events, which begins with the firing of motor units and 

culminates in the formation of actin-myosin cross-bridges within the myofibrils of 

the muscle. When the motor units of a muscle depolarize, action potentials are 

elicited in the fibers of the muscle and cause calcium ions to be released from the 

sarcoplasmic reticulum. The increase in calcium ion concentrations then initiates the 
cross-bridge formation between the actin and myosin filaments. In isolated muscle 

twitch experiments, the delay between a motor unit action potential and the 

development of peak force has been observed to vary from as little as 5 

milliseconds for fast ocular muscles to as much as 40 or 50 milliseconds for muscles 

comprised of higher percentages of slow-twitch fibers. The relaxation of muscle 
depends on the re-uptake of calcium ions into the sarcoplasmic reticulum. This re-

uptake is a slower process than the calcium ion release, and so the time required 

for muscle force to fall can be considerably longer than the time for it to develop. 

 

In the muscle simulations you will conduct in this lab, activation dynamics is 

modeled using a first-order differential equation with a variable time constant. This 
equation relates the rate of change in activation (i.e., the concentration of calcium 

ions within the muscle) to excitation (i.e., the firing of motor units): 

 

 �̇� =
(𝑥−𝑎)

𝜏(𝑎,𝑥)
 (1) 

 

where 𝑎 is the activation level of a muscle, 𝑥 is the excitation level, and 𝜏 is a variable time 
constant which is given by: 
 

 τ(a, x) = {
(τact − τdeact)x + τdeact, 𝑥 > 𝑎

τdeact                 , 𝑥 < 𝑎
 (2) 

 
In the above equation, the parameters describe the rates of rise of activation (𝜏𝑎𝑐𝑡) 

and deactivation (𝜏𝑑𝑒𝑎𝑐𝑡) in response to muscle excitation. In the model, activation 

is allowed to vary continuously between zero (no contraction) and one (full 

contraction). In the body, the excitation level of a muscle is a function both of the 

number of motor units recruited and the firing frequency of the motor units. Some 

models for excitation-contraction coupling distinguish these two control 

mechanisms (Hatze, 1976), but it is often not computationally feasible to use such 
models when conducting complex dynamic simulations. In the simulation, the 

muscle excitation signal is assumed to represent the net effect of both motor 

neuron recruitment and firing frequency, and, like muscle activation, is also allowed 

to vary continuously between zero (no excitation) and one (full excitation). The 

activation and deactivation time constants can be assumed to be 15 and 50 ms, 
respectively (Zajac, 1989, Winters 1990). 
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Muscle-tendon contraction dynamics 

The force producing properties of muscle are complex and nonlinear (see McMahon 

1984 for review). For simplicity, a lumped-parameter dimensionless muscle model, 

capable of representing a range of muscles with different architectures, is 

commonly used in dynamic simulation of movement (Zajac, 1989). In this model, 
the muscle force-length and force-velocity, and tendon force-strain relationships 

are represented by dimensionless curves (Figure 1).  

 

 

Figure 1. Dimensionless model of muscle and tendon used in our 

simulations. Muscle properties are represented by an active contractile 

element (CE) in parallel with a passive elastic element (top). Muscle force 

is dependent on muscle fiber length (middle plot) and velocity (right plot). 

Muscle is in series with tendon, which is represented by a nonlinear elastic 
element (left plot). Pennation angle (𝜶) is the angle between the muscle 

fibers and the tendon. The forces in muscle and tendon are normalized by 

peak isometric muscle force (𝑭𝑶
𝑴). Muscle fiber length (𝒍𝑴) and tendon 

length (𝒍𝑺
𝑻) are normalized by optimal fiber length (𝒍𝑶

𝑴). Tendon slack length 

(𝒍𝑺
𝑻) is the length at which tendons begin to transmit force when stretched. 

Velocities are normalized by the maximum contraction velocity of muscle 
(𝑽𝒎𝒂𝒙

𝑴 ). For a given muscle-tendon length (𝐥𝐌𝐓), velocity, and activation 

level, the model computes muscle force (𝑭𝑴) and tendon force (𝑭𝑻 ) . 

Four muscle-specific parameters are commonly used to scale the dimensionless 
curves for individual muscles: 
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• 𝐹𝑜
𝑀 maximum isometric muscle force  

• 𝑙𝑜
𝑀 optimal muscle fiber length  

• 𝑙𝑠
𝑇 tendon slack length and  

• 𝛼 pennation angle 

 

There are different choices of state that can be used for the muscle-tendon model. 

Either muscle-tendon force (Zajac 1989, Anderson and Pandy 1999) or tendon 
length (Winters 1990) is commonly used. In this lab, you will be using muscle 

length, which has been shown to have the advantage of not requiring inversion of 

the tendon force-strain curve (Schutte 1992). Thus the state equation for 

musculotendon dynamics can be given by: 

 

 𝑙�̇� = 𝑣𝑀(�⃗�, �̇⃗�, 𝑎, 𝑙𝑀) (3) 

 

where q⃗⃗ represents the generalized coordinates of the system, q̇⃗⃗ the vector of time 

derivatives of the generalized coordinates, a is the muscle activation and lM is the 

current muscle fiber length. During a forward dynamic simulation, muscle length 

and activation are treated as states and solved for by numerically integrating 

equations (1) and (3) simultaneously with the system equations of motion. Within a 
simulation, the muscle-tendon force (𝐹𝑀𝑇) acting on the skeleton is computed from 

the system states: muscle length, activation, generalized coordinates and 
generalized speeds. The generalized coordinates and generalized speeds of the 
system are first used to numerically compute the muscle-tendon length (𝑙𝑀𝑇) and 

muscle-tendon velocity (𝑙�̇�𝑇). For example, muscle-tendon length is computed by 

adding up the incremental lengths between muscle path points. Checks are included 

to see if wrapping surfaces are being contacted by the muscle and if so, the 

additional length required to wrap around a surface is included in the computation 
of the muscle-tendon length. Muscle-tendon velocities are computed similarly by 

adding up the incremental velocities between muscle path points. After computing 
lMT and iMT, the muscle activation is used along with the dimensionless curves 

shown in Figure 1, to compute the muscle-tendon force. 

 

In summary, we will be using degrees of freedom (positions and velocities), muscle 

length, and activation as the states of the system. Therefore, initial conditions for 
these quantities must be specified, and the main output of each simulation will be 

these states. 
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VI. Muscle Tug of War Model  
 

In this lab, you will use a simple mechanical model to investigate the dynamic 
properties of muscle-tendon actuators. The model consists of a block translating on 

a frictionless surface under the action of two opposing muscle-tendon actuators, 

i.e., a muscle tug of war (Figure 2). 

 

 

Figure 2. Model consists of a translating block on a frictionless surface 

being acted upon by two opposing muscles. The block is 0.1 x 0.1 m and 

has a mass of 20 kg. The distance between fixed supports is 0.7 meters. 
With the block centered, the muscle-tendon lengths are 0.3 m. 

 

At each step, you will investigate the controls in the GUI and the structure of the 

files. You will be editing the files listed in the next sections. 

 

1. Open the Simulation_Lab4.osim example. 
 
File → Open Model… → Simulation_Lab4.osim 

 

Use the mouse buttons to navigate the viewing window (left button rotates, 

middle button translates, right button zooms). 

 
How many degrees of freedom are in this model? What are they? 

 
What are the values of the four primary muscle parameters (Fo

M, lo
M, ls

T, αo) for 

each muscle? 

 

2. Load and Run the Simulation_Lab4_Setup_Forward.xml set up file 

 
Tools → Forward Dynamics… → Load… 

 

Select Simulation_Lab4_Setup_Forward.xml and click on Open. 

 

Look at the files that the setup file calls.  

 
What do the excitations for the muscles look like? Draw them. 

 

muscle 2 

z 

muscle 1 
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Press Run to start the simulation. You can watch the viewing window update as 

the simulation progresses. You can close the Forward Dynamic Settings window 
without affecting the simulation. 

 

3. Plot the results 

 
Tools → Plot… 

 
In this section, it is important to use the files that the simulation produces for 

your plots and NOT the default choices within the plotter. You can use the file 

that appears in the list to plot state variables (block_tz, activation, and fiber 

length). You can load a file to investigate other output variables like muscle 

force, where muscle force is computed using the Actuation analysis. 

 
Look through the files that were given to you. Where is the Actuation analysis 

called, and where are the results saved? 

 

Plot box position vs. time, muscle activations vs. time, and muscle force vs. 

time. 
 

You can experiment with changing muscle parameters in the GUI, saving the 

model, and rerunning the simulation to observe changes in the behavior of the 

muscles. In the next section, we’ll be doing more exploration of how muscle model 

parameter values affect simulation results. 

VII. Exploration Phase 
 
In this section, you will gain experience modifying the files needed to run dynamic 

simulations. You will also begin to look at how various muscle model parameters 

affect the dynamic response of a muscle-tendon actuator, insight that should aid 

your design of your optimal muscle for the virtual tug of war. 

 
1. For our explorations, we will use a modified tug-of-war model, with only one 

muscle (muscle_2). Modify the files that were given to you (save them as new 

files) to have a model with a single muscle at full activation starting at time 0. 

Make sure that file names are changed accordingly throughout to reflect your 

new files. 
 

List all of the changes you had to make to change the two-muscle simulation 

into a one-muscle simulation, and which files were affected. 

 

Zajac (1989) showed that the tendon-to-fiber length ratio (lS
T l0

M⁄ ) can have 

substantial effects on the mechanical response of a muscle-tendon actuator. The 

following sets of simulations are designed to have you vary the simulation code 

and parameters in order to examine the effect of tendon-to-fiber length ratio on 
the mechanical response of a muscle during isometric and isokinetic 

contractions. 
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2. Perform isometric (i.e., constant length) simulations with a range of tendon-to-
fiber length ratios and look at how this affects the force-time response. Use the 

GUI or alter the .osim file to lock the block position at 0. 

 

What is the syntax needed to lock the block in the .osim file? 

 
Alter the tendon-to-optimal fiber length ratio for several conditions (ls

T lo
M⁄ =

0.5, 1.0, 2.0, 4.0, 8.0). For each tendon-to-fiber length ratio, maintain the sum of the 

slack tendon length and optimal fiber length constant ( ls
T + lo

M = 0.3m). Run the 

forward simulations for each case. Remember to change your initial states file 
accordingly. 

 

Overlay curves of the muscle force-time histories for each tendon-to-fiber length 

ratio. Describe any differences that you see between the curves in terms of the 

rate of force development and steady state force achieved. Using what you know 
about muscle activation dynamics and muscle-tendon mechanics, explain why 

the muscle force responses differ the way they do with changes in tendon-to-

fiber length ratio. 

 

3. Perform isokinetic (i.e., constant velocity) simulations with a range of tendon-to-

fiber length ratios and look at how this affects the force-position response. Load 
the Simulation_Lab4.mot file. 

 
Alter the tendon-to-optimal fiber length ratio for several conditions (ls

T lo
M⁄ =

0.5, 1.0, 2.0). For each tendon-to-fiber length ratio, maintain the sum of the slack 

tendon length and optimal fiber length constant ( ls
T + lo

M = 0.3m). Perform a 

kinematic analysis by plotting tendon force vs. Simulation_Lab4 motion. 

 

Overlay curves of the tendon force-position histories for each tendon-to-fiber 

length ratio. Describe any differences that you see between the shapes of the 
curves. Using what you know about muscle-tendon mechanics, explain why the 

muscle force responses differ the way they do with changes in tendon-to-fiber 

length ratio. 
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VIII. Design Phase 
 

A muscle tug-of-war tournament will be held between members of the class. A 
match will consist of two muscles competing head-to-head (or muscle-to-muscle) in 

a one second tug of war. You will be required to specify the muscle-tendon 

parameters and excitation-time history subject to the constraints described below. 

In each tug of war, whichever muscle has moved the block onto their side at the 

end of one second will be declared the winner. Both muscles will start each match 

at rest with zero activation. 
 

Design variables – specify the following variables 

 
Fo

M Maximum isometric muscle force 

lo
M Optimal muscle fiber length 

ls
T Tendon slack length 

αo Muscle fiber pennation angle 

x(t) Muscle excitation time history 

 lMT Total muscle-tendon complex length (change ONLY z-location of muscle-P1) 

τact Activation time constant 

τdeact Deactivation time constant 

v̅max
M  Normalized maximum contraction velocity 

 

Other model parameters you will use 
 

AM Physiological cross sectional area in cm2 

VM Muscle volume 

σo
M Maximum isometric stress of muscle, assumed equal to 35 N/cm2 (Zajac 1989) 

 

Design constraints 
Fo

M = AMσo
M 

VM ≤ 100 cm3 

0.05 m ≤ lo
M ≤ 0.2m 

ls
T ≥ 0.1m 

0.15m ≤ lMT ≤ 0.4m 

0° ≤ αo ≤ 30° 

2 ≤ v̅max
M ≤ 10 

Fo
Mv̅max

M lo
M ≤ 175W 

∫ x(t)dt ≤ 0.5
1

0

 

10ms ≤ τact ≤ 20ms 

40ms ≤ τdeact ≤ 60ms  

30ms ≤ τdeact − τact ≤ 40ms  
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You are individually responsible for devising and implementing a process for 

designing your muscle-tendon actuator. Document the process and results clearly 
in a brief report. The report, excluding figures and tables, should not be more than 

2 pages. Include the following sections: 

 

• Introduction 

o Objectives of your design. 
 

• Methods 

o Outline of the steps used in your design process. 

 

• Results 

o Include a combination of mathematical analysis, parameter sensitivity 
studies, and results of prototype muscle simulations. 

o Description of the final muscle design, including a demonstration that 

each criterion is met. 

 

• Discussion 
o Justification of your final design. 

o Evaluation of the strengths and potential weaknesses of your design, e.g. 

under what conditions do you expect your muscle to perform well? 

 

• References if used  
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Appendix A. Storage files 
 

Create a storage file of muscle excitations (designed or from processed EMG) (all 
values should vary between 0 and 1). The file can be created in Excel, but must be 

saved as file_name.sto. The following headers and titles should be included: 

 

OpenSim Header (change italicized words to match file): 

 

file_name 
nRows = numberofdatarows 

nColumns = numberofdatacolumns 

endheader 

 

Note: No space should be left between the header and the row of column titles 
 

Column Titles: 

 

time     nameofmuscle1.excitation     nameofmuscle2.excitation      

 
Note: Muscles should be in the same order in which they appear in the force set of 

the .osim file. 


